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Chapter 1

OctaMED

1.1 The Project Menu

* Note: ‘Project’ here refers to a single song, or a combination ←↩
of

songs which make up a multi-module.

New Opens window:
New?

Clears the current project to let you start a new one.

Open Loads a song from disk. More

Play After On: OctaMED automatically starts playing a song after
Loading it is loaded. More

Save Opens window:
Save Options

Saves the current project to disk.

Save Opens window:
Save Timer

Timer Controls OctaMED’s automatic save facility.

Delete Deletes one or more files from disk. More
Files

Print Opens window:
Print Options

Prints the song in a variety of ways.

Command Opens window:
OctaMED Command Shell

Shell A Shell-like window to test OctaMED’s ARexx commands.

ARexx Execute an ARexx file. More
Script

Last Displays the last message (error or information) More
Message appearing on the screen’s title bar.
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Online Opens OctaMED’s help system (you’re using it now!). More
Help

About Displays information about OctaMED, its current More
language and its registered owner.

AmigaDOS Opens an AmigaDOS shell on the OctaMED screen. More
Shell

Audio Allocates/frees the Amiga’s internal audio channels. More
Channels

Quit Quits the program. More
OctaMED

1.2 The Display Menu

* All of these items open windows. Some of these windows - Tracker
editor, Main Control, Information - are usually open. You are
free to close them, however; use the appropriate menu items to
re-open them.

Tracker Opens window:
Tracker editor

Editor The main way of entering music in OctaMED.

Notation Opens window:
Notation editor

Editor For entering/reading music in traditional notation.

Main Control Opens window:
Main Control

OctaMED’s main control panel.

Information Opens window:
Information

Window Gives information on various properties of the song ←↩
.

Tempo Window Opens window:
Tempo

Controls the speed of the song.

Synth Editor Opens window:
Synthetic Sound Editor

For creating/editing ‘synthetic’ instruments.

Sample Editor Opens window: Sample Editor
For editing and digitizing ‘samples’ (the most
common instrument type).

Sample List Opens window: Sample List Editor
Editor For creating/editing a list of all your instruments.

MIDI Message Opens window: MIDI Message Editor
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Editor Sends/receives MIDI SysEx messages.

Input Map Opens window: Input Map Editor
Editor Allows control over OctaMED using your MIDI device.

ARexx Trigger Opens window: ARexx Trigger Setup Window
Setup Sets player commands to perform ARexx operations.

1.3 The Song Menu

Select Opens window: Song Selector
For selecting the current song (of a multi-module).

Add New Adds a new song after the final song. More

Delete Deletes the final song of a multi-module. More
Last

Playing Opens window: Playing Sequence
Sequence Controls the order in which to play blocks.

Section Opens window: Section List
List Controls the order in which to play song sections.

Set Opens window: Song Options
Options Contains some options related to the whole song.

Set Opens window: Relative Track Volumes
Volumes To set the volumes of the song’s tracks.

Set Opens window: Song Annotation
Annotation For attaching text to your song (e.g. greetings).

1.4 The Block Menu

New Adds a new block to the song. More

Insert Inserts a new block before the current block.

Append Adds a new block after the final block.

Insert Def As Insert, but the new block is given the default
size (64 lines of 4 or 8 tracks) rather than the
size of the current block.

Append Def As Append, but uses the default size.

Delete Deletes the current or last block. More

Set Opens window: Block Properties
Properties To change the properties of the current block.
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Block List Opens window: Block List
An at-a-glance list of blocks and some functions.

Highlight Opens window: Highlight Options
Options To regularly highlight Tracker editor lines.

Cut Copies the current block to the copy buffer, then More
clears it.

Copy Copies the block to the copy buffer. More

Paste Overwrites the block with the copy buffer’s contents. More

Swap Swaps the block with the copy buffer. More
w/Buff

All Cmd On (default): Cut and Copy affect all command pages. More
Pages Off: Cut and Copy affect the current page.

Insert Adds a new line at the cursor position. More
Line

Delete Removes the line at the cursor position. More

Expand/ Opens window: Expand/Shrink Block
Shrink Inserts lines between notes or deletes every nth line.

Split At Splits the current block into two blocks. The current More
Cursor line becomes the first line of the next block.

Join With Joins the current block with the following one. More
Next

1.5 The Track Menu

Cut Copies the current track to the copy buffer, then clears More
it.

Copy Copies the track to the copy buffer. More

Paste Overwrites the track with the copy buffer’s contents. More

Swap Swaps the track with the copy buffer. More
w/Buff

All Cmd On (default): Cut and Copy affect all command pages. More
Pages Off: Cut and Copy only affect the current page.

Insert Inserts an empty track before the current track, in just More
Empty the current block or over the whole song.

Delete Removes the notes / player commands in the current track. More
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1.6 The Instr Menu

Instrument Opens window: Instrument List
List A selectable list of the instruments in the song.

Type Opens window: Instrument Type
Choose the type of each instrument here.

Set Opens window: Instrument Properties
Properties Contains settings for each instrument in the song.

Load Loads one or more instruments from disk. More
Instrument(s)

Load from Opens window: Instrument Load Window
List A simplified Sample List Editor geared towards

loading the instruments in your list.

Save Saves the current instrument to disk, in the format More
Instrument you select from the submenu.

Flush Removes the current instrument from memory and More
Current clears all its properties.

Flush All Removes all instruments unused by the current More
Unused project.

Automatic On: A requester to flush unused instruments will More
Flush appear on pressing the Clear Current button in the

New Project window.

Add Path Adds the full path of the instrument when loaded. More

Remove Path Removes the path of the instrument before loading. More
(Only for songs saved without instruments.)

Halve Loaded On: Loaded samples will be ‘halved’ (in volume). More
Samples Automatically turned on in 5-8 channel mode.

Load Samples On: Any samples you load are stored in Fast memory. More
To Fast Mem Off: Loaded samples are stored in Chip memory.

Usually off, but turned on in Mix mode.

Move Samples Moves all samples in Chip memory to Fast memory. More
To Fast Mem

Move Samples Moves all samples in Fast memory to Chip memory. More
To Chip Mem

1.7 The Edit Menu

* Most items in this menu act on the current range. More

Cut Range Copies the range to the copy buffer, then clears it. More
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Copy Range Copies the range to the copy buffer. More

Paste Range Overwrites part of the current block with the copy More
buffer’s contents, starting at the cursor position.

Paste To As Paste Range, but inserts consecutive tracks in the More
Sel. Tracks copy buffer to consecutive selected tracks in the

block.

Erase Range Clears the notes in the range. More

All Cmd On (default): Cut and Copy affect all command pages. More
Pages Off: Cut and Copy affect the current page.

Discard Copy Frees up the memory occupied by all three copy More
Buffers buffers.

Transpose Opens window: Transpose
To transpose and change notes and instrument numbers.

Replace Opens window: Replace Notes
Notes Searches for particular note(s) and replaces them.

Range Curr. Marks a range over the whole of the track that the More
Track cursor is on.

Range Curr. Marks a range over the whole of the current block. More
Block

Re-mark Brings back the most recently marked range. More
Range

Spread Notes Opens window: Spread Notes
Spreads notes across consecutive tracks.

Pitch Slide Creates a pitch slide. Type 2 replays the note after More
sliding to it; type 1 does not.

Volume Slide Creates a volume slide using player command 0C. More

Generic Creates a slide using any type of player command. More
Slide

Note Echo Opens window: Note Echo
Produces automatic echoes using player command 0C.

1.8 The MIDI Menu

MIDI Active On: Activates MIDI. More

Input Active On: You may use your MIDI device to enter notes. (As More
long as MIDI Active and Edit mode are on.)

Slave Mode On: Activates MIDI Slave Mode. OctaMED can now be More
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Active controlled by a MIDI sequencer.

Input Opens window: Input Channel
Channel Sets the MIDI input channel.

Send Sync On: Sends synchronization information when Song Play More
or STOP is clicked.

Ext Sync On: External synchronization (an external MIDI device More
sends sync info instead of OctaMED). Input Active
must be on.

Send Active On: Periodically sends active sensing messages. More
Sensing

Send Out On: Replays input MIDI notes. Useful for owners of a More
Input separate sound module and keyboard.

Read On: Records key-up events in the Tracker editor. More
Key-Up’s

Read Volume On: Records the volume of received notes (as 0C More
volume commands).

Immediate On: Sends a preset change message immediately when an More
Preset instrument’s Preset value is changed. (Otherwise,
Change OctaMED waits until a note is next played with it.)

Reset Pitch/ Resets pitchbenders, modulation wheels and presets on More
Presets all channels.

Send MIDI Sends a ‘MIDI Reset’ message ($FF). More
Reset

Send Local Sends a ‘Local Control On / Off’ message. More
Control

Note The method used for switching all notes off when the More
Killing song is stopped. $Bx 7B 00 is recommended.

SMF Load Opens window: SMF Load Options
Options Options used when loading Standard MIDI Files.

Controller Opens window: MIDI Controllers
Commands Set player commands to send control change commands.

1.9 The Settings Menu

Mouse Opens window: Mouse Options
Options Sets the function of each mouse button when editing.

Keyboard Opens window: Keyboard Options
Options Some options for editing with the keyboard.

Programmable Opens window: Programmable Keys
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Keys A shortcut for entering notes.

Keyboard Opens window: Keyboard Shortcuts
Shortcuts Set almost any key combination to do almost anything!

Mixing Opens window: Mixing Settings
Settings Concerns playing in Mix mode.

FastMemPlay Opens window: FastMemPlay
Allows playing Fast memory samples in 4-channel mode
(and non-paired tracks in 5 to 7-channel mode).

Aura Sampler Opens window: Aura Sampler Options
Controls for HiSoft’s 16-bit sound board, Aura.

Equalizers Opens two different ‘equalizer’ windows. More

Miscell- Opens window: Miscellanenous Options
aneous Contains a variety of options.

Screen A couple of screen options. More

Screen Mode Changes OctaMED’s screen mode.

Like WB On: The screen has the same properties as the
Workbench screen.

Auto-Freeze On: Automatically ‘freezes’ the OctaMED screen when More
Screen it is not the frontmost. This frees more processor

time for multitasking.

Font Opens window: Font
To set the font used in three different areas.

Palette Opens window: Palette
Alters the screen’s colors.

Windows Various facilities for storing a window’s position in More
memory (‘snapshotting’). ‘Opened’ affects opened
windows, ‘All’ affects all windows, otherwise just
the current window is affected.

Load Loads a new settings file. More
Settings

Save Saves the current settings under the name More
Settings ‘PROGDIR:Soundstudio.config’.

Save Saves the current settings under any name. More
Settings As

1.10 The New? Window

PURPOSE
Clears the current project to let you start a new one.
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HOW TO OPEN
Project menu.

Where?
GADGETS

> Clear All More
Removes all samples and songs from memory.

> Clear Current More
Clears the current song.

> Cancel
Closes the window.

1.11 The Save Options Window

PURPOSE
Saves the current project to disk.

HOW TO OPEN
Project menu.

Where?
GADGETS

* Top
> GetFile gadget

Opens a file requester to select a filename. More
> Text box

Contains the filename for saving.

* Miscellaneous section
> Save Secondary Data More

- On
Saves some extra information with the song.

- Off
Only necessary information is saved.
> Create Icon More

- On
Saves a Workbench icon file with the song.
> Save Notation Data More

- On
Saves notation editor information with the song.
> Save Instruments More

- On
Instruments are saved with the song.

- Off
When the song is reloaded, its instruments are individually
loaded using your sample list.
> Cycle gadget More

- Save Multi-Module
Saves all songs in the multi-module.

- Current Song Only
Saves the currently selected song in the multi-module.

* File Format section More
> Radio button

- MMD2 (V5 and above)
Supports all OctaMED features.

- MMD1 (V3 and above)
Supports all features but saves in a format compatible
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with OctaMED V3 and V4.
- MMD0 (MED & OctaMED)

Supports many features. Compatible with MED 2.10 and all
versions of OctaMED.

- SMF Type 0
Standard MIDI File Type 0 format.

- Executable File
Saves as an executable file. You can run this file from
the Workbench or a shell.

* Lower section
> Compression More

- No Compression
Does not compress the song.

- PowerPacker Compr.
Compresses using powerpacker.library.

- SFCD Compression
Compresses using Stephan Fuhrmann Compact Density
(lh.library).

- XPK Compression
Compresses using an XPK library.
> Settings More

Opens window:
PowerPacker Settings
[for PowerPacker Compr.]

XPK Settings
[for XPK Compression ]

> Calculate Size
Calculates the project’s size in bytes if it were saved using
the current settings.

> Packed
Calculates the compressed size in bytes. (Can take time.)

* Bottom
> Save

Saves the song using the above settings.
> Exit

Closes the window.

1.12 The PowerPacker Settings Window

PURPOSE
Contains settings for PowerPacker compression (songs only). More

HOW TO OPEN
Save Options window.

Where?
GADGETS

> Speedup Buffer
- Large/Medium/Small

Bigger buffers consume more memory but speed up compression.
> Efficiency
- Fast/Mediocre/Good/Very Good/Best

Better efficiency produces smaller files but reduces
compression speed.

> Exit
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Closes the window.

1.13 The XPK Settings Window

PURPOSE
Select the compressor used in XPK compression (songs only), and More
adjust its settings.

HOW TO OPEN
Save Options window.

Where?
GADGETS

> Cycle gadget
- All compressors contained in the LIBS:Compressors directory

Allows you to select the compressor used.
> Information box

Gives information on the selected compressor.
> Efficiency

Better efficiency produces smaller files but reduces
compression speed.

> Password
For use only with encryption compressors. The password you
enter will need to be provided when the song is re-loaded.

1.14 The Save Timer Window

PURPOSE
To start/stop automatic song saving, and change related settings. More

HOW TO OPEN
Project menu.

Where?
GADGETS

> Time Between Saves (mins)
Contains the time in minutes between each save, or 0 if the
facility is switched off.

> Active
- On

The song will be automatically saved every given number of
minutes.

- Off
The song must be manually saved by opening Save Options.

> Open Save Window
- On

The Save Options window is opened before every save.
- Off

The window is only opened the first time that the save time
elapses.

1.15 The Print Options Window
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PURPOSE
Prints the song in Tracker editor format, with various information. More

HOW TO OPEN
Project menu.

Where?
GADGETS

* Output File section
> GetFile gadget

Opens a file requester to select a filename. More
> Text box

Contains the filename for (optionally) printing to a file.

* Range section
> Start Block

The number of the first block to be printed.
> End Block

The number of the last block to be printed.
> All Blocks

Sets Start/End Block to cover all the blocks in the song.
> Current Block

Sets Start/End Block to the current block.

* Options section
> Cycle gadget

- Don’t Print Blocks
Does not print any blocks (use to only print the header).

- Print As Text
Prints the blocks in the selected range.
> Print Header

- On
Prints the ‘header’ (various information) before the song
contents.
> Form Feed

- On
Prints a form feed after printing each block.

* Bottom
> Print

Starts printing.
> Exit

Closes the window.

1.16 The OctaMED Command Shell

PURPOSE
For testing OctaMED’s ARexx commands. More

HOW TO OPEN
Project menu.

Where?
NOTES

* Type in any OctaMED ARexx command, in upper or lower case, with More
any necessary parameters, then press Return to execute it.

* Type a command name followed by ? to show the command’s template.
For example, typing WI_OPEN ? displays NAME/A.

* Type cls or clear (then Return) to clear the window.
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* Two extra ways of closing the window: press Ctrl-\ or type bye.

1.17 The Tracker Editor

PURPOSE
The main way of entering music in OctaMED. More

HOW TO OPEN
Automatically opened when OctaMED starts up. Reopen through the
Display menu.

Where?
WINDOW FEATURES

> Title bar
Format is ‘Block a/b - Cmd Page c/d’, where:

a: Block currently being displayed
b: Last block in song
c: Player command page currently being displayed
d: Last command page in this block

> Scroll bars plus arrows
Scroll the display horizontally and vertically.

> Number in top-left corner
The number of tracks in this block.

> Pairs of blue buttons along the top
- Numbers

Track numbers (tracks are columns). When blue, the track is More
‘on’ - that is, the track will be played when the song or
block is played. When grey, the track is ‘off’ - that is,
the track’s notes will be temporarily ignored.

- S buttons
Shows whether or not the track is ‘selected’. Used in some
editing operations (e.g. Transpose, Replace Notes, Chord).

> Left-hand column of three-digit numbers
Line numbers (lines are rows).

> White bar
The current line. The grey patch is the cursor. More

> Block contents
‘Full notes’ of the form ‘nnoiittll’, where:

nn: Note name
o: Octave number
ii: Instrument number (first digit may be a space)
tt: Player command type
ll: Player command level

+ Note name + octave number = a note
+ Player command type + player command level = a player command More
+ All parts together = a full note More

1.18 The Notation Editor

PURPOSE
Displays the song in standard musical notation. More

HOW TO OPEN
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Display menu.
Where?
WINDOW FEATURES

> Title bar
Format is ‘Block a/b - Lines c-d (last e)’, where:

a: Block currently being displayed
b: Last block in song
c: First Tracker editor line displayed
d: Last Tracker editor line displayed
e: Last line in this block

> Scroll bars
- Left-hand vertical More

Selects which part of the song to display in the window.
- Right-hand vertical More

Scrolls the display vertically (useful if you have more than
2 staffs).

- Horizontal More
Scrolls the display horizontally (useful if your staff is
longer than the window).

> Staffs
The rows of 5 lines inside the window. Shows the notes in the
part of the song selected by the left-hand scroll bar.

MENU STRIP

* Project
> Print

Opens window:
Print Notation

Prints the song in standard musical notation.
> Exit Notation Editor

Closes the window.

* Windows
> Assign Tracks

Opens window:
Assign Tracks

Controls which tracks are shown on which staffs, and the
direction of the stems of notes.

> Staff Setup
Opens window:

Staff Setup
To add or remove staffs, and change their properties.

> Signatures
Opens window:

Signatures
Mainly to set the song’s time and key signature.

> Tools
Opens window:

Tools
To select a note or rest to add to a staff.

> Display Setup
Opens window:

Notation Display Setup
Contains settings relevant to the general display.
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1.19 The Print Notation Window

PURPOSE
Prints the song in standard musical notation. More

HOW TO OPEN
Notation editor’s Project menu.

Where?
GADGETS

* Range section
> Start

The number of the first ‘displayful’ of measures to be
printed. Change the number of measures per displayful in the
Notation Display Setup window (Measures slider).

> Current
Sets Start to the current displayful.

> End
The number of the last displayful.

> Current
Sets End to the current displayful.

* Lower section
> Resolution

- 1$\times$ (Std Font)
Prints using standard Amiga fonts.

- 2$\times$, 4$\times$, 8$\times$ (CG Font)
Prints using the higher-quality Compugraphic font. Higher
numbers mean better quality but slower print speeds and use
of much more memory (8$\times$ uses 64 times the memory of 1$\times$).

* Bottom
> Print

Starts printing. Click Stop in the requester to interrupt.
> Exit

Closes the window.

1.20 The Assign Tracks Window

PURPOSE
Controls which Tracker editor tracks are displayed on which staff, More
and the direction of the stems of their notes. More

HOW TO OPEN
Notation editor’s Windows menu.

Where?
GADGETS

* Track column
The number of each Tracker editor track.

* Staff # (0 = none) column More
The staff number that each track is assigned to. If 0, the
track is not displayed on any staff.

* Stem More
- Auto

The stem of each individual note on the track will go up or
down, depending on the note’s pitch.

- Up
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The stems of all of the track’s notes will go up.
- Down

The stems of all of the track’s notes will go down.

* Bottom
> Up

Shifts all track numbers up by 8.
> Down

Shifts all track numbers down by 8.
> Exit

Closes the window.

1.21 The Staff Setup Window

PURPOSE
Add/remove staffs, and change their properties. More

HOW TO OPEN
Notation editor’s Windows menu.

Where?
GADGETS

* Upper section
> Information box

Format is ‘Current Staff a/b’, where:
a: Currently-selected staff number
b: Total number of staffs
> Arrow buttons

Select a staff (for use by other gadgets in this window).
> Staff Name More

The selected staff’s name.
> Insert New Staff

Inserts a new staff before the selected one.
> Append New Staff

Adds a new staff after the last one.
> Delete Staff

Removes the selected staff.

* Lower section
> Space Above More

The amount of space, in pixels, above the selected staff.
> Space Below More

The space below the selected staff.
> Clef

The selected staff’s clef (Treble, Bass or Alto).
> Middle C oct More

The octave number corresponding to middle C on the staff.
(When set to 2, for example, note C-2 is middle C.)

> Def. Instr More
The default instrument used on the staff.

* Bottom
> Exit

Closes the window.

1.22 The Signatures Window
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PURPOSE
Mainly to set the song’s time and key signature.

HOW TO OPEN
Notation editor’s Windows menu.

Where?
GADGETS

* Time Signature: More
> Sliders

Together set the time signature of the song. E.g. to set the
time signature to 3/4, set the top slider to 3 and the bottom
to 4.

* Middle section
> Information boxes

Show the number of measures in this block (dependent on the
time signature), and the leftover Tracker editor lines after
the last measure (ideally should be 0).

> Add Measure More
Adds a new measure to the block, setting Leftover lines to 0.

> Rem Measure More
Removes the last measure or part-of-measure.

* Key Signature: More
> Slider

Sets the key signature. The value is the number of sharps or
flats (positive value = sharps, negative value = flats).

> Information box
The name of the major (and relative minor) key with the
selected key signature.

> Harmonic Minor Scale More
Sharpens the 7th note of the scale (affects entering notes).

* Bottom
> Exit

Closes the window.

1.23 The Tools Window

PURPOSE
To select a note or rest to add to a staff.

HOW TO OPEN
Automatically opened with the notation editor, but can be reopened
through the Notation editor’s Windows menu.

Where?
GADGETS

* 8 note boxes More
Select one to add it to a staff.

> Whole note (Semibreve) 16 lines
> Dotted half-note (Dotted minim) 12 lines
> Half-note (Minim) 8 lines
> Dotted quarter-note (Dotted crotchet) 6 lines
> Quarter-note (Crotchet) 4 lines
> Dotted 8th-note (Dotted quaver) 3 lines
> 8th-note (Quaver) 2 lines
> 16th-note (Semiquaver) 1 line
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* 8 rest boxes More
Select one to add it to a staff.
(Names and number of Tracker editor lines as above.)

* Next section
> Length

The length (in Tracker editor lines) of the selected
note. You can type in any custom length (up to 31).

> # and b More
Makes an existing note sharp or flat. Click on # or b,
then click on the note in the notation editor window.

> Information box More
Various properties corresponding to the mouse pointer’s
position on the staff. Format is ‘L:a B:b-c N:d’, where:

a: Tracker editor line number
b: Beat number
c: Part-of-beat number (e.g. 3 usually means the 3rd

semiquaver)
d: Note name (shown when the left mouse button is held)

* Right-hand section
> Information box

Format is ‘Sa Trk b/c: d’, where:
a: Staff currently being edited
b: Assignment number of track currently being edited
c: Total number of tracks assigned to this staff
d: Actual number of track currently being edited
> Slider

Selects which track assigned to this staff to edit.

1.24 The Notation Display Setup Window

PURPOSE
Contains settings relevant to the general display. More

HOW TO OPEN
Notation editor’s Windows menu.

Where?
GADGETS

* Main section
> Display Width More

The width, in pixels, of all staffs.
> Scale More

Sets Display Width to such a value that the whole staff width
can be seen in the window.

> Default More
The default width, in pixels, of all staffs. (Saved with
settings, unlike Display Width.)

> Display Staff Names More
- On

Staff names are displayed to the left of staffs.
- Off

Staff names are not displayed.
> Measures More

The number of measures shown on the screen at any one time.
> Positioning Mode More

Affects the order in which the song’s blocks are shown, when
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dragging the notation editor’s left-hand vertical scroll bar.
- Block-based

Displays the blocks in numerical order.
- Song linear

Displays the blocks in the order in which they appear in
the playing sequence. (So some blocks may be repeated, some
blocks may never be shown.)

* Bottom
> Exit

Closes the window.

1.25 The Main Control window

PURPOSE
Contains some important general functions and displays.

HOW TO OPEN
Automatically opened when OctaMED starts up. Reopen through the
Display menu.

Where?
GADGETS

* Left section [play area]
> Song Play More

Plays the current song from the very beginning.
> Song Cont More

Continues the current song from the current line.
Shift-click to continue from the first line. How?

> Block Play More
Repeatedly plays the current block.

> Block Cont More
Continues the current block from the current line.

> D More
(Delay) Starts playing the block when you next enter a note.
Edit mode must be on.

> STOP More
Stops playing the song / block / note.

* Main horizontal section [instrument area]
> Information box More

The current instrument’s number.
> GetFile gadget More

Loads one or more instruments from disk.
> Text box More

The current instrument’s name (empty if nameless).
> Information box More

The current instrument’s size (------- if empty).
> SList

Opens window: Instrument Load Window
A simplified Sample List Editor geared towards loading the
instruments in your list.

> Type
Opens window: Instrument Type
Choose the type of each instrument here.

> Props
Opens window: Instrument Properties
Contains settings for each instrument in the song.
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> Edit
Opens window: Sample Editor , or if the current instrument
is of type Synth, opens window:

Synthetic Sound Editor

* Remaining gadgets [edit area]
> Edit

- On
You may enter notes/player commands into the song. Can also More
edit various other parts of OctaMED (e.g. MIDI messages). More

- Off
Cannot alter the song. Use to play notes with the keyboard. More
> Space

+ Shift-click to switch on and open Keyboard Options.
- On

A set number of lines are skipped when a note is entered More
into the song.
> Chord More

- On
Can enter chords. Hold down the keys of the chord, and
OctaMED enters the notes on consecutive tracks.
> Oct More

Shows which octaves are currently in use when you play the
Amiga’s keyboard. The two digits refer to the lower and
middle octaves.

1.26 The Information window

PURPOSE
Contains useful information and provides access to some common
windows.

HOW TO OPEN
Automatically opened when OctaMED starts up. Reopen through the
Display menu.

Where?
TITLE BAR

Shows the current tempo (song speed) settings: SPD or BPM, Tempo More
slider value, and TPL slider value.

GADGETS

* Top row
> Sg

Opens window: Song Selector .
For selecting the current song (of a multi-module).

> Information box More
Number of current song / Total number of songs.

> Arrow gadgets More
Select a new song (in a multi-module).

> Sc
Opens window: Section List .
Controls the order in which to play song sections.

> Information box More
Current section list position / Total no. of positions.

> Sq
Opens window: Playing Sequence .
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Controls the order in which to play blocks.
> Information box More

Current playing seq. position / Total no. of positions.
> B

Opens window: Block List .
An at-a-glance list of blocks and some functions.
(Shift-click B to open Block Properties )

> Information box More
Format is ‘a/b:c’, where:

a: Current block number (starting at 0)
b: Number of last block
c: Current block name (often doesn’t exist).

* Bottom row
> Left information box More

Shows free memory (Chip and Fast).
> Middle information box More

The song playing status or current disk activity.
> Right information box

Contains the song channel mode, MIDI status (M: MIDI active;
I: MIDI Input active) and Edit/Space/Chord status.

> Timer
Minutes and seconds that have elapsed since Song Play or More
Block Play was last clicked. Click on the timer to restore More
the most recently saved song position.

> R
Resets the timer to 00:00, and stores the current song More
position (current line, playing sequence and section list More
position).

1.27 The Tempo Window

PURPOSE
To set the playing speed of the song. More

HOW TO OPEN
Display menu.

Where?
GADGETS

* Top
> Mode

- SPD More
The more technical mode, based on the regular ‘ticks’ used
to keep OctaMED in time.

- BPM More
Beats Per Minute mode.
> Cycle gadget More

- NRM
Plays at normal speed.

- 2/3
Plays at two-thirds the given speed.

- 1/2
Plays at half the given speed.
> Edit

Opens window:
Tempo Operations
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.
Provides tempo conversion facilities and more.

* Main section
> Tempo

The main slider for selecting the speed of the song.
SPD mode:

The value is the time between each tick.
4-channel/MIDI/Mix: Higher values mean faster speeds.

Possible values: 11 - 240
5 to 8-channel: Lower values mean faster speeds.

Possible values: 1 - 10
BPM mode:

The value is the number of beats per minute.
Higher values mean faster speeds.

> TPL
The number of Ticks Per Line. Really for SPD mode only.

> LPB
The number of Tracker editor Lines Per Beat (BPM mode).

> Slow HQ More
Compatibility switch for OctaMED V3/V4 songs using HQ mode.

1.28 The Tempo Operations Window

PURPOSE
Mainly to convert between the various methods of setting the tempo.

HOW TO OPEN
Tempo window.

Where?
GADGETS

* Conversion
Changes to and from various modes, while keeping (roughly) the
same speed. (Only affects the Tempo window’s Tempo slider)

> SPD -> BPM More
Converts from SPD to BPM mode.

> BPM -> SPD More
Converts from BPM to SPD mode.

> 4 Ch -> 8 Ch More
(SPD mode) Converts from 4-channel to 5 to 8-channel (very
rough).

> 8 Ch -> 4 Ch More
(SPD mode) Converts from 5 to 8-channel to 4-channel.

> Change Commands More
- On

All 0F (‘set Tempo slider’) player commands in the song
will be altered to reflect the new tempo.

* Bottom
> Insert Tempo Change More

Enters the current Tempo setting as an 0F player command.
> Set Current Tempo As Default More

Stores the current tempo settings (SPD/BPM, Tempo, LPB, TPL),
and recalls them when the song is cleared.

> Exit
Closes the window.
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1.29 The Synthetic Sound Editor

PURPOSE
Creating and editing synthetic sounds (‘synthsounds’). More

HOW TO OPEN
Display menu; Main Control’s Edit button (if the current instrument

Where?
is of type Synth).
Where?
MENU STRIP

* Project
> New Synthsound More

Sets the current instrument’s type to Synth (if necessary),
then clears the whole synthsound.

> Reset Temp Wave More
Clears the right-hand (‘temporary’) waveform and sets its
length to 128.

> Exit Synth Editor
Closes the window.

* Presets
Select one of these ready-made waveforms to insert it into the More
current waveform display.

> Clear Wave More
Clears the current waveform.

* Waveform
> Change Volume

Opens window:
Synthsound Volume

.
Changes the volume of the range.

> Stretch
Opens window:

Synthsound Stretch
.

Stretches a point in the waveform towards another point.
> Start Transformation More

For use with multiple waveforms. Marks the current waveform
as the start of a ‘transformation’.

> Do Transformation More
Marks the current waveform as the end of a transformation,
then does the transformation. The start waveform now
gradually changes into the end waveform (look at the
waveforms in between to see the results).

GADGETS

* Waveform displays (speckled boxes on either side of the window)
+ Select a waveform display by clicking on it.
+ Draw ‘freehand’ inside a waveform by dragging the mouse. More
> Left-hand waveform

The actual current instrument (playable from the keyboard).
> Right-hand waveform

For temporary editing - it doubles as a copy buffer.

* Buttons between the displays More
> Copy

Copies one waveform to the other (in the arrow direction).
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> < Swap >
Exchanges both waveforms.

> <Mix
Mixes the left waveform with the right waveform.

> <Add
Like <Mix with a slightly different calculation (adds instead
of taking the average).

> UNDO
Reverses the effects of the last editing operation.

> Script
Opens window:

SynthEd Script
To create and edit a simple ‘script’ for your synthsound.

* Draw Mode section (bottom-middle)
+ Concerns ‘drawing’ (dragging the mouse) on a waveform More
> Top cycle gadget

- Pixel
Draws in pixels.

- Line
Draws straight lines.

- Range More
Marks a range (see later).
> Bottom cycle gadget

- Direct
Draws without mixing.

- Mix
Mixes the drawn pixels/lines with the existing waveform.

* Section below the left-hand waveform
> Waveform: More

- Number box
Current waveform number (changeable).

- Information box
Current waveform number in hex / Total number of waveforms.

- Arrows
Display previous/next waveform.
(Click with Shift held to display first/last waveform.)
> Length: More

The length of the waveform (2 - 128, in steps of 2).
> New Waveform More

Adds a new waveform after the last one.
> New Here More

Inserts a new waveform before the current one.
> Delete Last More

Deletes the final waveform.
> Delete Current More

Deletes the current waveform.

* Section below the right-hand waveform
> Range All More

Marks a range over the whole of the current waveform.
> Cut More

[Left waveform only] Moves the range to the right waveform,
and clears the range.

> Copy More
[Left waveform only] Moves the range to the right waveform.

> Paste More
Copies the right waveform to the range’s start in the left
waveform. The existing waveform is overwritten.



OctaMED 25 / 26

> Clear More
Clears the range.

> Double More
Halves the range horizontally then repeats it, making the
pitch one octave higher.

> Reverse More
Turns the range backwards.

> << and >> More
Shifts the ranged section to the left or right.

* Range: section (bottom-right) More
> Upper number box and arrows

The start of the range. Can be changed using the arrows.
> Lower number box and arrows

The end of the range. Can be changed using the arrows.
> |< and >|< and >|

Mark a one-byte range (‘cursor’) at the start, middle or end.

1.30 The Synthsound Volume Window

PURPOSE
Increases/decreases the volume of the marked range. More

HOW TO OPEN
Synthetic Sound Editor’s Waveform menu.

Where?
GADGETS

> Volume Factor:
The percentage volume change required. E.g. 50 halves volume.

> OK
Changes the volume and closes the window.

> Cancel
Closes the window without changing the volume.

1.31 The Synthsound Stretch Window

PURPOSE
Stretches a point on the waveform towards another point. More

HOW TO OPEN
Synthetic Sound Editor’s Waveform menu.

Where?
GADGETS

> Stretch Value:
The amount of stretching required. A negative value stretches
the point to the left.

> OK
Changes the volume and closes the window.

> Cancel
Closes the window without changing the volume.
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1.32 The SynthEd Script Window

PURPOSE
To create and edit a simple script for your synthsound, controling More
the volume, pitch, and order of waveform play.

HOW TO OPEN
Automatically opened with the Synthetic Sound Editor. Re-open
through the Synthetic Sound Editor.

Where?
MAIN DISPLAY

Sequences: Pitch Volume
| |

000 00 40 00
001 01 END END
002 02
003 03
004 04 (etc.)
| |

Line numbers: Decimal Hexadecimal

GADGETS

* Top-right section
> Insert More

Inserts a sequence entry [equal to the Return key].
> Delete More

Deletes the current entry [equal to the Del key].
> Transition More

Creates a run of numbers in a sequence. E.g. if the previous
entry is 00, and the current entry is 09, clicking Transition
produces 00 01 02 03 04 05 06 07 08 09.

* Speed: section More
> Volume

Sets the speed at which the entries in the volume sequence
are handled (the ‘execution speed’), in ‘ticks’. For example,
value 4 executes an entry every 4th tick.

> Wave
Sets the execution speed of the pitch sequence (also called
the ‘waveform sequence’).

NOTES ON EDITING More

* To scroll around the sequences, use <up> and <down> or the scroll
bar, or use the F6 - F10 keys as in the Tracker editor.

* Make sure Edit mode is on (Main Control).

* To enter commands, move the cursor to the leftmost position of a
sequence (using <left> and <right>), and press the command’s key.

* To change command values, position the cursor over the number to
be changed and type in the new value.

* ALL command values in the sequence are in hexadecimal!

ALSO SEE
Synthetic Sound Commands
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